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1 Introduction 
1.1 About mods 
Players can modify or extend many aspects of the game by creating mods, e.g. changing 
characters, items, spells, quests, or adding brand-new content. This document provides an 
overview of creating, applying and publishing mods for Black Geyser: Couriers of Darkness, 
including Steam Workshop support. 

The game, without any mods, is referred to as the vanilla game. 

Mods can be enabled or disabled before launching the game by using the Black Geyser Mod 
Manager. They are stored in the GrapeOcean\BlackGeyser\data\mods folder within the user’s 
directory. 

1.2 Technical essentials 
Mods can be created by using the Black Geyser Modding Toolkit, a standalone application 
available as a free download on https://www.blackgeyser.com/modding. You can also find tutorial 
videos on this website. 

The Modding Toolkit allows you to explore the internal contents of the game, offering several 
editors and features to customize the game. It includes a Savegame Editor as well. 

When you edit game files with the Modding Toolkit, your changes will be applied to Black Geyser 
without modifying the original game files. This is achieved through a special mechanism designed 
for loading mod content. If you wish to revert your changes in the game, simply disable your mod 
in the Mod Manager, and you're all set. However, please note that the Savegame Editor is an 
exception: changes made to save games will modify your local save files directly, since they are 
not treated as mod content. 

  

  

https://www.blackgeyser.com/modding
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2 Using mods 
2.1 The Mod Manager 
To use mods, make sure you have the latest version of Black Geyser: Couriers of Darkness. 
Modding support is only available since the 2024 December update (v1.2.61 - Update 30) of the 
game. The Mod Manager automatically starts when Black Geyser: Couriers of Darkness is started. 
You can disable this by selecting the Skip launcher option in Steam or using the -nolauncher 
command line argument in the Steam or GOG client. 

 

 

2.2 Installing mods 
To add a new mod to the game, use the All available mods menu. If you use Steam, you can use 
the Steam Workshop button to browse available mods on Steam Workshop. If you use GOG, or 
you would like to add a mod from an external source, you can use the Add mod button and select 
the mod file on your computer. 

To download a mod from Steam Workshop, use the  Subscribe button under the mod image. 

To delete a mod, use the  Unsubscribe button. This will remove the mod from your computer. 

2.3 Enabling mods and modsets 
To load a mod when the game starts, it must be added to the current modset. You can create or 
change modsets on the Modsets page. 

To add a new mod to the current modset, use the  Add mod button on the page. 
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To disable all mods, you can use the Disable all button on the Modsets page. Alternatively, you 
can create a new, empty modset and select it. 

Certain mods are dependent on each other which means that another mod must be installed as 
a prerequisite. The Mod Manager warns the user when such dependencies are present and only 
allows enabling a mod when all prerequisites are enabled as well. 

2.4 Mod components 
A mod may contain multiple distinct features called mod components which the user can enable 
or disable individually. Mod components can be enabled or disabled by selecting a mod and 
expanding the Mod components menu by using the  show components button on the Modsets 
page. 

To disable a mod or mod component, select the mod and use the  disable button on the 
Modsets page. To remove a mod from the current modset, use the  delete button. 

If two or more loaded mods try to change the same game element (e.g. the same character or 
item), the change by the mod which is loaded the latest will take effect. You can rearrange the 
mods in the modset to control this behavior. 

2.5 Settings 
You can change the language, the theme and the font size of the Mod Manager in the Options 
menu. These changes only affect the Mod Manager. You can also change the game executable 
path in case you have multiple different installations of Black Geyser: Couriers of Darkness. 
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3 Modding 
3.1 The Modding Toolkit 
Mods are created by using the Black Geyser Modding Toolkit, a standalone application available 
as a free download on https://www.blackgeyser.com/modding. To use the Modding Toolkit, a copy 
of Black Geyser: Couriers of Darkness is required.  

The Modding Toolkit provides a convenient way to edit game files, create new content, and save 
them into a mod. Additionally, you can edit save games using the Savegame Editor of the toolkit.  

 

At first start, the Modding Toolkit will perform two operations: 

• Extract the game data files from the installation directory 
• Extract the game asset files from the installation directory 

The extracted files are stored in the local file system, in the user’s directory. Extracting the assets 
is a lengthy process which can be canceled by the user. The process can be restarted by selecting 
the Run export command from the Assets menu. 

Extracting the game files must be repeated when a new version of Black Geyser: Couriers of 
Darkness is released. This is done automatically when an update is detected. 

When using certain features of the Modding Toolkit, a running Black Geyser: Couriers of Darkness 
is required. The game must be launched with the “-devconsole” command line argument (without 
quotes). The “Launch Game with devconsole” command in the Mod editor menu provides a 
convenient way to launch the game with the dev console. 

https://www.blackgeyser.com/modding#header
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3.2 Creating new mods 
To create a new mod, select the Create new mod from the Mod editor menu on the top menu bar. 
This will create an empty mod. 

The mod identifier must be a unique name which identifies the mod. The Mod Manager will not 
allow loading two mods with the same identifier. The identifier must also be unique when 
uploading the mod to Steam Workshop. 

You can use the minimum or maximum compatible fields to set which game versions are 
supported by the mod. The mod will not be compatible with any game version below the minimum 
or newer than the maximum. You can leave these field empty if you don’t want to restrict mod 
compatibility. To determine the version of the installed game, open the version.txt file in the game 
directory.  

It is possible to change the mod identifier and any other mod properties using the Window / Mod 
editor menu on the main menu toolbar. 

3.3 Editing mods 
The Modding Toolkit provides a set of tools and editors to create and modify mod contents: 

• Mod Editor: change the properties of the currently opened mod. 
• Explorer: this is a file browser that shows the original game data files. 
• Mod contents: this window shows the contents of the current mod component. 
• Language Tool: you can use it to change any localized text in the game. 
• Variable Editor: edit the variables representing the internal state of the game with this 

editor. 
• Asset Browser: shows game assets (audio or images) added to the mod. 
• Form editors: these are used to edit the game data files, including items, creatures and 

spells. 

Each mod may contain two types of files: game data files (also known as descriptors) and asset 
files (audio or images). The Modding Toolkit provides editors to edit the game data files. External 
tools are required to edit asset files. 

Double click on a game file descriptor in the Explorer or the Mod contents window to open it using 
the default editor. You can save your changes by using the Save command in the File menu. 

When saving any game content, the changed descriptor is added to the mod. The Modding Toolkit 
does not make any change in the original game folder. 

To add a new asset, or modify an existing one, the edited asset file must first be added to the mod 
by using the Asset Browser. The asset in the mod directory can be edited by external tools. 

3.4 Exporting and installing mods 
To save a mod to the local file system, select the Export mod file command in the Mod Editor 
menu. This will pack the mod into one file which can be loaded into the game by using the Mod 
Manager, or distributed to the public. 

To install a mod, you can use the Add mod button on the All available mods page in the Mod 
Manager. The Modding Toolkit also provides a shortcut for this: press the Send to Mod Manager 
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button in the Mod editor menu and the mod will be automatically loaded into the Mod Manager. 
This feature is intended for testing local mods. 

3.5 Uploading mods to Steam Workshop 
You can use the Mod Manager to distribute a mod in the Steam Workshop. First, export the mod 
and add it into the Mod Manager by using the Export mod or the Send to Mod Manager commands. 

Start and log into the Steam client if it is not already running. 

Open the Mod Manager and go to the All mods page, then open the Steam Workshop menu. 

 

Click on the Upload mod button and select the mod you want to upload.  

You must be the author of the mod, and you must set a unique mod identifier before you can 
upload it to Steam Workshop. 

By clicking the Upload button, you automatically accept the Steam Workshop terms of service 
agreement. 

You shouldn’t subscribe to your own mods. If you upload your mod to Steam Workshop and you 
subscribe to it, you will receive a mod loading error in the Mod Manager. The reason for this is that 
your local mod and the mod downloaded from Steam Workshop have the same mod id. This is 
corrected by unsubscribing from your mod in Steam Workshop or deleting the local version of your 
mod. The two mods are exactly the same, so the recommended solution is to not subscribe to 
your mods.  Subscribing to your own mod will also create the same problem when you export a 
new version of your mod from the Modding Toolkit and try to upload it to Steam Workshop. 
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3.6 Editing save games 
The Savegame Editor is part of the Modding Toolkit that enables you to edit the game’s save files. 
While not strictly a modding feature, it is helpful for altering the saved game state when testing 
mods. 

When you edit a save game, your local save files will be directly modified, meaning they are not 
handled or exported as mod content. 

To open the Savegame Editor, use the Window menu on the main menu toolbar. 
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4 Advanced Modding 
4.1 Editing mode 
Editing mode can be used to edit certain area elements directly from the running game, including 
spawn points, area triggers, position markers, containers etc. 

 

To enter editing mode, launch Black Geyser: Couriers of Darkness, then start or load a new game 
and press F9. 

You can use the Editing mode menu to view, edit and add game elements to the area. Your changes 
are automatically sent into the Modding Toolkit which saves your changes to the appropriate area 
descriptor file and add the file to your mod.  

If you edit an area descriptor using the editing mode, make sure that the descriptor is not edited 
simultaneously using the Modding Toolkit. Editing in parallel will result in write conflicts and 
possible loss of data. 

Tips for using Editing Mode: 

- Press F1 to open the in-game development console 
- Use the console command area <area_code> to switch to the area you want to edit. The 

list of areas is available in the Modding Toolkit, by expanding the areas folder. Example: 
‘area TW1_2’.  

- To leave editing mode, press the Restart Area button. You can also reload an existing save 
game from the main menu. 

- Do not edit the same area in the Modding Toolkit if it is already opened in Editing Mode. 

4.2 The development console 
To access the development console, run the game with the -devconsole argument. You can set 
this in the Steam or GOG Galaxy client under the game’s properties. 
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To open the in-game development console, start a new game or load an existing save game, then 
press the F1 key. 

Type help into the console and press enter to list the available commands. 

4.3 Descriptor folder structure 
The descriptor files are organized into subfolders according to their type. Use the Explorer to 
browse these files and open them. 

The following list describes the most important descriptor types: 

- Areas: they contain all area related data, including spawn points, area triggers and 
containers. You cannot currently create new areas using the Modding Toolkit, but it is 
possible to change them. It is also possible to use the in-game F9 Edit Mode to place and 
edit spawn points, area triggers, position markers, environment infos and usables directly 
in the game area. 

- Creatures: they describe an in-game creature, including player characters, neutral NPCs 
and enemies. It is possible to create new creatures or change existing ones by using the 
Modding Toolkit. You can place creatures on the area by placing Creature Spawns via 
editing mode (shortcut: F9) directly from the game. 

- Items: they describe an in-game item. It is possible to create new items by using the 
Modding Toolkit. 

- Spells: they describe an in-game spell. You can create new spells, or modify existing 
spells. You cannot create new spell effects, however. 

- Quests, Dialogs and Cutscenes: these together are used to create quests and various in-
game events, NPC interactions, etc. 

4.4 Overwriting descriptors 
Currently, Modding Toolkit supports file-based modding only. When you make a change to a 
descriptor, the whole descriptor file is placed in the mod, including all of its unchanged properties 
as well. This means that if two or more (enabled) mods modify the same descriptor, the descriptor 
from the mod which is loaded the latest will take effect. The Mod Manager will display a warning 
if it detects such incompatibilities when the player tries to enable a mod. 

A notable limitation resulting from file-based modding is related to game areas.  It is currently not 
possible to modify the same area for multiple mods without overwriting each other's changes. For 
example, if your mod places new creatures or items in the same area as another mod, and both 
mods are enabled in the Mod Manager, only the changes from the last loaded mod will take effect 
in the area. The area’s name will be shown in the warning when the player enables the mods in the 
Mod Manager, allowing the player to make an informed choice about which mods they want to 
use. 

4.5 Using custom asset files 
You can use your own image and audio files in your mods. 

Currently supported formats are as follows: png for images, and wav, ogg for audio. 

It is possible to use a completely new asset file and refer to it in your descriptors, or you can 
override an existing asset file and replace it everywhere in the game. 
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To use a custom asset file, open the Mod asset browser from the Window menu. 

The left panel shows the asset files available in the vanilla game. The right panel shows the asset 
files added to your mod. You can select an asset file on the left panel and add it to the mod using 
the Add to mod assets context menu command. You can then use the Open enclosing folder 
context menu command to open the location of the file in your mod component and use your 
favorite editor to change the file. 

Alternatively, you can use the Add new asset file context menu command to add your own asset 
file under the audio or textures folder in your mod. 

You can later select these files in the form editor when editing a game descriptor. 

For example, to change the inventory image of an item, open the item descriptor in the Mod 
Manager and click on the Browse button under Material and Appearance / Icon. This opens the 
Mod asset browser window where you can select your asset file. 

4.6 Localization 
To add or change localized content, run the Language Tool from the Window menu.  

The Language Tool shows a list of hierarchically organized keys. You can edit the corresponding 
value in the editor window after selecting a key. 

Keys are automatically created for the English language when creating or duplicating descriptors. 
However, they must be manually added for other languages. Use the Tools / Sync language files 
menu in the Language tool to add any missing language keys for the currently selected language. 

The top level of the key hierarchy roughly follows the descriptor types. See the table below for the 
most important descriptors. 

Top level language key Descriptor 
AREA Areas 
CRE Creatures 
DIA Dialogs 
ITM Items 
QST Quests 
SPELL Spells 

 

Expanding these lists, you will find a list of names matching the descriptors. Expanding a 
descriptor shows a list of language keys. To edit localized content, you can select a key and enter 
or change the localized text. 

For example, to edit the description of the Grandmaster’s Wardstone item, open the Language 
Tool, select your language, then select Keys/ITM/agelas_wardstone/Description and enter your 
text in the Key Editor window. After saving your changes, the modified translation file will be placed 
into your mod file. 


